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Hind

Ueh TSI ATk e T & STt Gg &l GIgerdT & 3R 310 el | ShetdT g2

(A) ffaRfen Ren (B) Worm
(C) Rwn wefiram (D) grsamR
English

Is a standalone malware computer program that replicates itself and spreads to other computers?

(A) Operating System (B) Worm

(C) Disk Cleanun (DY Hardware

>> Correct: (B) Worm

Hind

ferst Siiftea IR & fhe A= A Emphasis e Iuere giar 8?2

(A) Style (B) Tool menu
(C) Edit menu (D) Insert menu
English

In which menu of LibreOffice Writer is the Emphasis option available?
(A) Style (B) Tool menu

(C) Edit menu (D) Insert menu

>> Correct: (A) Style
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Q.3 MCQ

Hind

1 & O fhg 2ifdape Foft & gRT 57 T 3159 TR et gearast ot e sroeiis e Tohd 872

(A) Shift+ U (B) Ctrl+ L
(C)Ctrl+U (D) Shift+ L
English

Which of the following shortcut keys can be used to directly upload a document to Google Drive?

(A) Shift + U (B) Ctrl + L

(C) Ctrl+ U (D) Shift + L

>> Correct: (A) Shift +U Shift + U

Q.4 McQ

Hind
= 7 & Ta QR R fEargd o a1 g?
(A) CD-R (B) Hard Drive

(C) Laptop (D) Magnetic Tape

English

Which of the following is the oldest storage device?
(A) CD-R (B) Hard Drive

(C) Lanton (D) Maanetic Tane

>> Correct: (D) Magnetic Tape Magnetic Tape

Q.5 MCQ

Hind

59 clulefel # s g s 4 R gl &7
(A) &t Saretst (B) fom Aaatsh

(C) &R aicrstt (D) Mesh eiatatstt

English

In this topology, nodes are connected to other nodes?

(A) Tree Topology (B) Ring Topology
(C) Star Tonoloav (DY Mesh Tonoloav
>> Correct: (D) Mesh Topology Mesh Eidrarstt
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Q.6 MCQ

Hind

fos siffthe Impress & sif@isad Zoom fhamm gtar 82

(A) 100 (B) 200
(C) 300 (D) 3000
English

What is the maximum Zoom in LibreOffice Impress?

(A) 100 (B) 200
(C) 300 (DY 3000
>> Correct: (D) 3000 3000

Hindi
IDL &1 9T ATH 4T §iaT 82

(A) gcethy sSfthaer st (B) Ecethd SRREE aivaeT
(C) gexite e ddw (D) $cxthd STeT eSSt
English

What is the full form of IDL?

(A) Interface Definition Language (B) Interface Direct Language

(C) Internet Definition Lanauaae (D) Interface Data Librarv

>> Correct: (A) Interface Definition Language

Q.8 MCQ

Hind

= & g9 affuRfd A ot 36T vy quié Fgi aear a?

(A) fetrersr (B) et
(C) uzres (D) smgaiaH
English

Which of the following operating systems is not supported by the Umang App?

(A) Linux (B) Windows
(C) Android (D) iOS
>> Correct: (A) Linux forTerm
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Q.9 MCQ

Hind

IRURe: ddbetenl A 3ret +t Ffafad ot oigax g+t anfae g2

(A) Oeter s (B) et Repifmier
(C) wffr (D) Heuristics
English

Traditional techniques still include all of the following except?

(A) Parallel Processing (B) Pattern Recognition
(C) Searchina (D) Heuristics
>> Correct: (A) Parallel Processing WRete AT

Hind

TS Tl o SR gH H1g A 7 el ST 9ehd 87

(A) 7139 T g1 (B) %138 W 31ge faeten gy
(C) R W faiah gt (D) &9 & aig 7ol
English

How can we go directly to the menu during a slide show?

(A) By mouse click (B) By right clicking on the slide

(C) Bv clickina on the ribbon (D) None of these

>> Correct: (B) By right clicking on the slide

Q.11 MCQ

Hind

UPI & Aread & 97 ST &R Shged T 27

(A) Drop (B) Send
(C) Pop (D) Push
English

What is sending money via UPI called?

(A) Drop (B) Send
(C) Pan (D) Push
>> Correct: (D) Push Push
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Q.12 MCQ

Hind

=1 7 @ ot & fors Siffthe €09 & afse A= o Sifee 78l 62

(A) e (B) eprdt
(C) gwefiche (D) A1 &eam
English

Which of the following is not an option in the Edit menu of LibreOffice Impress?

(A) Cut (B) Copy

(C) Dunlicate (D) Paae Setun

>> Correct: (D) Page Setup ST Tearg

Q.13 MCQ

Hind
HISTHIUIEER T SMMASHR T g &1?
(A) 1970 (B) 1983

(C) 1979 (D) 1981

English

When was the microprocessor invented?
(A) 1970 (B) 1983

(C) 1979 (D) 1981

>> Correct: (A) 1970 1970

Q.14 MCQ

Hind

fSeais & FAafar & §?
(A) Robert (B) Noah glass

(C) satoshi nakamoto (D) Kevin ashton

English

Who is the creator of Bitcoin?

(A) Robert (B) Noah glass
(C) Satoshi Nakamoto (D) Kevin Ashton
>> Correct: (?) Satoshi Nakamoto Satoshi Nakamoto
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Q.15 | FORMULA MCQ

Hind

FLOOR(1589,11) a1 AT <RIT gITT?

(A) 1584 (B) 1585
(C) 1590 (D) 1600
English

What will be the value of =FLOOR(1589,11)?

(A) 1584 (B) 1585
(C) 1590 (D) 1600
>> Correct: (A) 1584 1584

Hindi
UPI e &Y stfdreham wfarg et gielt &7

(A)3 (B) 4
(C)5 (D)6
English

What is the maximum length of UPI PIN?
(A) 3 (B) 4

(C) 5 (D) 6

>> Correct: (D) 6

Q.17 MCQ

Hind

3w vy fohe ARt & g fosam man?
(A) B domera (B) farem #=mer
(C) setagien Uz amgét Hamera (D) 78 & ig ol

English

From which Ministry was the Umang App launched?

(A) Ministry of Finance (B) Ministry of Education
(C) Ministrv of Electronics and IT (DY None of these
>> Correct: (C) Ministry of Electronics and IT SeteR11-eh U8 SITSE! HATerd
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Q.18 MCQ

Hind

I T HHTS ATSaT § e afchTT SRRaes @ 872

(A) SWDS (B) CWD
(C) PWSD (D) PWD
English

Which command shows the current working directory in Linux?

(A) SWDS (B) CWD
(CY PWSD (DY PWD
>> Correct: (D) PWD PWD

Hind

Fte fehed et SUANT &R e & folg forst 3iffthe Calc Wsefte &t feha=it ufcai gfad et Y smasgehar gidt 8?2

(A)2 (B) 3
(C) 4 (D) 5
English

How many copies of a LibreOffice Calc spreadsheet are needed to use the 'Collate’ option for printing?

(A) 2 B 3

) 4 (D) 5

>> Correct: (A) 2

Q.20 MCQ

Hind

&4 forg ey @ Tgex i wiga ot NEus A sect Tohd 872

(A) Save as (B) Import as
(C) Export as (D) None or these
English

Which option allows us to convert a Writer file to PDF?

(A) Save as (B) Import as
(C) Exnort as (DY None of these
>> Correct: (C) Export as Export as
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Q.21 MCQ

Hind

Ctrl + F3 giiéehe droit ohT geaHTe fohwrdh foig fovam Strar g2

(A) Capitalize each word (B) Sentence case
(C) Cycle case (D) Toggle case
English

For what purpose is the shortcut key Ctrl + F3 used?

(A) Capitalize each word (B) Sentence case
(C) Cvcle case (D) Toaale case
>> Correct: (C) Cycle case Cycle case

Hind

fefstr & et gu oo & ot 7 srearr-aaett & forg o v & ST 82

(A) Alt + Tab (B) Ctrl + Tab
(C) Shift + Tab (D) Shift + Alt
English

Which is used to switch between open programs in Windows?
(A) Alt+Tab (B) Ctrl + Tab

(C) Shift + Tab (D) Shift + Alt

>> Correct: (A) Alt + Tab Alt + Tab
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Q.23 MCQ

Hind

MIME &1 Q=T M ........?

(A) AeURYST 2T el e (B) AU ge¥et Bl Ugme s
(C) aediuet geRA3Fe Bl Uages (D) SWRIad & ¥ &g gl
English

What is the full form of MIME........ ?

(A) Multipurpose Internet Mail Extensions (B) Multiple Internal Mail Extension
(C) Multiple International Mail Extension (D) None of the above
>> Correct: (A) Multipurpose Internet Mail Extensions HeRIURUST e Aol aie s
Q.24 MCQ
Hind
BOSS @Al 93T TH 3T gidl 872
(A) Binary Operating System Solution (B) Bharat Operating System Service
(C) Bharat Operating System Service (D) None of these
English

What is the full form of BOSS?

(A) Binary Operating System Solution (B) Bharat Operating System Service
(C) Bharat Operatina Svstem Service (DY None of these

>> Correct: (A) Binary Operating System Solution Binary Operating System Solution

Q.25 MCQ
Hind

TRae (J13eR) 319+ 31u IR Thgi Ue e &7

(A) Facebook (B) Instagram
(C) Telegram (D) Twitter
English

Where do writers post their thoughts?

(A) Facebook (B) Instagram
(C) Telearam (DY Twitter
>> Correct: (D) Twitter Twitter
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Q.26

Hind

DSL fohg UehR & ST bl IGTEL0T &7
(A) sifsas
(C) arRerg

English

DSL is an example of what type of connection?
(A) Broadband

(C) Wireless

>> Correct: (A) Broadband

MCQ

(B) Network

(D) Local Area Network

g

Hind

HRRGIE dd STSeR # fUiT [dehed & &0 # UgHT ST Hehel &7

(A) Menu > Tool > Print

(C) Menu > Print

English

(B) Menu > Options > Print

(D) Menu > More Tool > Print

The print option in Firefox web browser can be accessed as?

(A) Menu > Tool > Print

(C) Menu > Print

>> Correct: (C) Menu > Print

(B) Menu > Options > Print

(D) Menu > More Tool > Print

Menu > Print

Q.28

Hind

fora siiftee Trger & Rwice ToR §exhy .......... 7

(A) Standard Toolbar

(C) Sidebar

>> Correct: (A) Standard Toolbar

CCCwale.com
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MCQ

(A) ®=E @ ar (B) Al & IR
(C) @88 IR (D) e ar

English

The default user interface in LibreOffice Writer is ........... ?

(B) Formatting Toolbar

(D) Print Bar

Wed ga ar
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Q.29 MCQ

Hind

RPA &7 QUi &9 &7 gidT 87

(A) Robotic process automation (B) Robotics program automation
(C) Robotic process application (D) Real-time process automation
English

What is the full form of RPA?

(A) Robotic Process Automation (B) Robotics Program Automation
(C) Robotic Process Annlication (D) Real-time Process Automation
>> Correct: (?) Robotic Process Automation Robotic Process Automation

Hind

AT TS &l gfdfelft a1 &t 2iicehe goft @ gidt 82

(A) Ctrl +V (B) Ctrl+ C
(C) Ctrl + Shift+ C (D) Ctrl + Shift + V
English

What is the shortcut key to copy selected text?
(A) Ctrl +V (B) Curl+C

(C) Ctrl + Shift + C (D) Ctrl + Shift + VV

>> Correct: (B) Ctrl +C Ctrl + C

Q.31 MCQ

Hind

forst aiifthe wrger & 8fdn 2 & forg forw 2ifdare Goft o1 wi fovar ST &2

(A) Ctrl +1 (B) Ctrl + 2
(C)Ctrl +3 (D) None
English

Which shortcut key is used for Heading 2 in LibreOffice Writer?

(A) Ctrl+1 (B) Ctrl+2
(C) Ctrl + 3 (D) None
>> Correct: (B) Ctrl +2 Ctrl + 2
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Q.32 MCQ

Hind

1SS § UM e ! ST ST ThdT B, ... =g & QI G IS gRI?
(A) &1gS oMt A=Y (B) Insert Menu
(C) View Menu (D) =i T8t
English
Action buttons can be added to a slide by the action button command of the ......... menu?
(A) Slide Show Menu (B) Insert Menu
(C) View Menu (D) None
>> Correct: (D) None &S gl
(ORCK] MCcQ
Hind

Ueh o IR H Tt fiet ot fmmest A & forg fohe 2iidane ot ot il fokarm STrar €2

(A)Win +D (B) Win + W
() Win+M (D) Ctrl+ M
English

Which shortcut key is used to minimize all windows at once?

(A) Win+D (B) Win+W
(C) Win +M (DY Ctrl + M

>> Correct: (C) Win + M Win + M

Q.34 | FORMULA MCQ
Hind

QUOTIENT(509.8,7) &1 {1 &1 g2

(A) 70 (B) 72
(C)72.82 (D) 500
English

What will be the value of =QUOTIENT(509.8,7)?

(A) 70 B) 72
(C) 72.82 (D) 500
>> Correct: (B) 72 72
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Q.35 MCQ

Hind

TR ETgH T BielT 82

(A) Seek time (B) Latency time
(C) Seek + Latency time (D) All of these
English

What is access time?

(A) Seek time (B) Latency time
(C) Seek + Latencv time (D) All of these
>> Correct: (C) Seek + Latency time Seek + Latency time

Hindi
Tfaer & Tdie & rfchan fahaw sier gid &7

(A) 140 (B) 280
(C) 300 (D) 400
English

What is the maximum number of characters in a Twitter tweet?
(A) 140 (B) 280

(C) 300 (D) 400

>> Correct: (B) 280

Q.37 MCQ

Hind

OLX ferads siaifa amar 8?2

(A) C2B (B) B2C

(C)B2B (D) C2C

English

Under what category does OLX fall?

(A) C2B (B) B2C
(C) B2B (D) C2C
>> Correct: (D) C2C c2c
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Q.38 TIF

Hind

sz AR TifdT g @it it srgafa a1 82
(A) True (B) False

English

LinkedIn allows job posting and searching?

(A) True (B) False

>> Correct: (A) True True

Q.39 TIF

Hind

09 1 &l I R T&AT Shgd 87
(A) True (B) False

English

Are 0 and 1 called binary numbers?

(A) True (B) False

>> Correct: (A) True True

Q.40 |FORMULA MCQ

Hind

SUM(5,2) &hT |- &IT gITT?

(A)3 (B) 7
(C) 10 (D) 25
English

What will be the value of =SUM(5,2)?

(A) 3 | 7
(C) 10 (DY 25
>> Correct: (B) 7 7
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Q.41 TIF

Hind

forst afffthe wrgex & 9w ok foww o9 # arer-31eT Footer gt Gad 87
(A) True (B) False

English

In LibreOffice Writer, can even and odd pages have different Footers?

(A) True (B) False

>> Correct: (A) True True

Q.42 TIF

Hind

TUTIR Yfeetel ehed & At NNTP Wicteniel bl S&aHTA foham ST 82

(A) True (B) False

English

Is NNTP protocol used for publishing news?

(A) True (B) False

>> Correct: (A) True True

Q.43 TIF

Hind

Al & a1 & ®9 # John McCarthy &t STHT STTaT §?
(A) True (B) False

English

Is John McCarthy known as the father of Al?

(A) True (B) False

>> Correct: (A) True True
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Q.44 TIF

Hind

Rewritable cd-rom dhae Ue & ohH bl IHAT &l 87
(A) True (B) False

English

Does a rewritable CD-ROM support only reading operations?

(A) True (B) False

>> Correct: (B) False False

Q.45 TI/F

Hind

gerHs Sfiad saifa ar g & 1000000 deb &Y TfA g 6t St 82
(A) True (B) False

English

Is an amount of up to ?10,00,000 provided in Pradhan Mantri Jeevan Jyoti Bima Yojana?

(A) True (B) False

>> Correct: (B) False False

Hind

fHiE grue Sex-e dfdwT & sidia armar 872

(A) True (B) False

English

Does a Demand Draft come under internet banking?

(A) True (B) False

>> Correct: (B) False
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Q.47 TIF

Hind

fafsra arafdemar &1 srgva syl arafdewar ek dafifa arafawdr & aal @t sigar g?
(A) True (B) False

English

Does the experience of mixed reality combine elements of virtual reality and augmented reality?

(A) True (B) False

>> Correct: (A) True True

Hind

G J&NT | POS &l chael gTSdAR AT SITdT 87

(A) True (B) False

English

Is POS considered only hardware in the retail industry?

(A) True (B) False

>> Correct: (B) False

Hind

fdsist 10 g5 @ieH & g Soiae SiTwM &1 3w fdhar SIar 87
(A) True (B) False

English

Is the Inject option used to open a drive in Windows 107?

(A) True (B) False

>> Correct: (A) True
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Q.50 TIF

Hind

TR HIg T g1 9 [ Reaia @te glar 82
(A) True (B) False

English

Is the full form of QR code Quick Response Code?

(A) True (B) False

>> Correct: (A) True True

Q.51 T/F

Hind

foicpeg i fastuaret & @ g fagtar arga L g2
(A) True (B) False

English

Is live streaming one of the features of LinkedIn?

(A) True (B) False

>> Correct: (A) True True

Q.52 TIF

Hind

&) ST BT U GHTT S8l U &l FehdT &7

(A) True (B) False

English

Can two friends have the same email address?

(A) True (B) False

>> Correct: (B) False False
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